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Content of package

WidePIX CHROMATIC Industry (or SenseEdge) detector
PoE Injector - IEEE 802.3bt (PoE++) - 95 W

Ethernet cable M12 to RJ45 Cable Assy CAT6a ethernet 1m
2x quick coupling for water cooling (for 4x6 mm plastic hose)
USB memory stick with control software Pixet Pro

Magnet — for IP address reset

M12 connector (optional; not required when using PoE)

1. Start guide

Device Setup and Safety

1.

The device should be positioned securely to avoid falls or damage caused by contact with other
objects

Connect the device to the water-cooling system. Thermal stabilization to 22 °C is strongly
recommended. Overheating can cause damage to the device.

Connect the Ethernet cable. Use a shielded Cat6a (or higher) Ethernet cable, 23 AWG
recommended, up to 30 meters. The cable must support 1 Gb/s or higher

a. Using PoE
Connect the Ethernet cable to an external PoE injector or PoE-enabled switch. The injector
or switch must support IEEE 802.3bt Type 3 (PoE++) and deliver at least 60 W of power.
Both the power delivery and the data transfer are provided by the Ethernet cable.
Important: The device will not operate with lower power ports.

b. Alternative — Without Poe
Connect a +48V DC power adapter to the device’'s power connector. In this configuration,
the Ethernet cable is used only for data transfer and should be connected directly to your
computer. Warning: Do NOT combine PoE with the power adapter.

LAN requirements

Connect the Ethernet cable from the PoE injector (or from device if not using PoE) directly to the
network card or via a gigabit switch with no load on other ports.

To fully utilize the WidePIX CHROMATIC Industry, network card must support speeds of at
least 1 Gb/s.

If there is a slower or more complex network between the WidePIX and the computer,
the framerate may be limited, bad frames can occur, or some measurements may fail.
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Network Configuration and IP Addressing
1. From factorial setting IP address is set 192.168.1.100 and Subnet mask 255.255.255.0

2. If the device was previously used and the IP was changed but is now unknown, device requires
the reset of IP address (see the IP address reset tutorial, below this section).

3. To ensure correct communication, modify the network settings on your PC.

a. Change network settings for Windows 11
(older Windows versions are very similar, see YouTube tutorial Network setting Windows 10)

[) Go to Start > Settings > Network & Internet > Ethernet
[l) Select the Ethernet connection used for the device

[l) In IP assignment, click on Edit, see Figure 1: Network setting W1

Q, Find a setting

Network & internet > Ethernet

CS Ethernet 2 ~
Not connected
Authentication settings Edit
Metered connection of @

Some apps might work differently to reduce data usage when you're connected to this network

Set a data limit to help control data usage on this network

IP assignment: Automatic (DHCP) Edit
DNS server assignment.  Automatic (DHCP! Edit
Manufacturer: lealtek Copy
Description: Realtek USB GbE Family Controller

Driver version: 1156.13.420.2023

Physical address (MAC):  D0:46:0C:FF:90:E1

Ethernet
C'? '\I:-:E:rul:-:g“- cted ~

Figure 1: Network setting W1
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IV) Set Edit IP setting to Manual and then switch On IPv4, see Figure 2: Network setting W2.

Edit IP settings

Manual

1Pv4
® ) off

IPv6
® ) Of

Save Cancel

Figure 2: Network setting W2

V) Additional settings will pop-up, fill up IP address and Subnet mask as shown below and click
on Save button. Note: last number of IP addresses should be different from IP addresses of
device (use 2-254). Example: If device IP is 192.168.1.100 you need to use different, for
example 192.168.1.200, subnet mask is always 255.255.255.0 see bellow Figure 3: Network
setting W3

Edit IP settings

Manual ~

IPv4
@ o

IP address

192.168.1.200

Subnet mask

255.255.255.0

Gateway

Preferred DNS

DNS over HTTPS

Off ~

Alternate DNS

Save Cancel

Figure 3: Network setting W3
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VI) Now you can connect to detector. Open your web browser and type IP address of device
192.168.1.100 (this is IP from factorial setting or after IP reset, if changed use new set one).
Page with ADVACAM interface should open in your browser. In bottom panel you can
update/change default IP address if needed. See Figure 4: Network setting W4

~ 4 Advacam Network Configuratic X +

€« c I A\ Not secure  192.168.1.100

{}IQE

ANDVALC

Current Settings

Version
Serial Number

MAC Address
1P Address
Subnet Mask

Gateway

IP Settings
Fixed IP Address
Fixed Subnet Mask
Fixed Gateway
Enable DHCP

Enable AutolP

AM

Network Settings

310-3.21
16781

70-b3-d5-ef-4c-bd
192.168.1.100
256.255.255.0
192.168.1.1

192 (163 1100
255 (255 255 [0
192 168 1
O

O

Update

1

© Copyright 2022 ADVACAM.

Figure 4: Network setting W4
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b. Change network settings for macOS 13

See Network Setting for MacOS (second part of YouTube video tutorial)

) Go to Apple menu ®> System Settings, click Network [& in the sidebar, click a network
service you want to edit, see Figure 5: Network setting M1.

[ ] Network
Q USB 10/100/1000 LAN
- Self-assigned IP
Sign in
with your Apple ID Wi-Fi
Connected

Software Update
Available

Firewall

Inactive

Wi-Fi
Bluetooth
_ Other Services
— Thunderbolt Bridge
L) Notifications W& e Not connected
) sound
v 7

Focus
8 Screen Time
=) General
Appearance

Accessibility

=9 Control Centre
B siri & spotiight
U Privacy & Security

E] Desktop & Dock

Figure 5: Network setting M1
[l) Click TCP/IP in the sidebar, edit Configure IPv4 to Manually, fill up IP address and Subnet

mask as shown below and click on OK button. Note: last number of IP addresses should be
different from IP addresses of device (use 2-254). Example: If device IP is 192.168.1.100 you
need to use different, for example 192.168.1.200, see Figure 6: Network setting M2.

M @ Not connected Configure IPv4 Manually &
I I IP address 192.168.1.200
Subnet mask 255.255.255.0
Router
Configure IPv6 Automatically &
Router Router
Cancel oK

Figure 6: Network setting M2
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[lI) Now you can connect to detector. Open your web browser and type IP address of device
192.168.1.100 (this is IP from factorial setting or after IP reset, if changed use new set one).
Page with ADVACAM interface should open in your browser. In bottom panel you can
update/change default IP address if needed.

. o < I 1921681100 I M+ ©

ANDVALCAM

Network Settings

Current Settings
Version 310-3.21
Serial Number 16781
MAC Address T0-b3-d5-ef-dc-bd
IP Address 192.168.1.100
Subnet Mask 255.255.255.0
Gateway 192.168.1.1

IP Settings
Fixed IP Address 182 168 1 100
Fixed Subnet Mask 256 255 (256 O
Fixed Gateway 192 188 1 1
Enable DHCP
Enable AutolP

© Copyright 2022 ADVACAM.

Figure 7: Network setting M3

c. Change network settings (for Linux)

[) Click on the network icon in the top-right corner of your screen (Wi-Fi or wired symbol).
ll) Select £+ icon for Settings.

[l) Inthe Network settings window, pick your connection from the left sidebar. Click the gear icon
+ next to your active network.

IV) Go to the IPv4 tab. Change the Method from Automatic (DHCP) to Manual.

V) Enter your IP address 192.168.1.200, Netmask 255.255.255.0 Note: last number of IP
addresses should be different from IP addresses of device (use 2-254). Example: If device IP is
192.168.1.100 you need to use different, for example 192.168.1.200

VI) Click Apply.

VIl) Disconnect and reconnect to the network to apply changes.
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IP address reset

=

Connection to a cooling system is required for proper operation of the device.

N

Disconnect the device from any network if connected.

e If connected via PoE, disconnect Ethernet cable from PoE injector to PC,

e If connected to a classical power supply, disconnect Ethernet cable from device to PC

3. Connect power via PoE (or Power supply)

4. Afterthe device init (R1is Orange, changes to Red and turns off), attach the magnet to magnetic
sensor (see Figure 8 below). When the magnetic field is recognized, R1 turns Blue. If R1 starts
blinking Blue, you have missed the IP mode change time window (~5 s after power up) and need
to start the process over.

5. When the change mode is enabled, R1 changes to one of the colors indicating the actual settings
(listed below).

6. Use magnet for selecting the preferred settings. There are 3 possibilities of the R1 color for

different IPv4 configurations:

e Red = Auto IP (random 169.254. ..)
e Green = DHCP (required DHCP server running on router/computer)
. = Static IP (set default 192.168.1.100)

7. Wait for several seconds. R1 blinks several times and turns off. Now the setting is saved.

8. Connect the device to the specified network.

Note: More information on IP address change and a short video guide can be found on our wiki:
https://wiki.advacam.cz/wiki/WidePix POE v2 Quick Start Guide

Magnetic sensor

Figure 8: Illustrative render for WidePIX CHOMATIC Industry bottom view. Symbols L, R, 1-4 are
not engraved on the actual device
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Description of LED indicators

The WidePIX CHROMATIC Industry panel is equipped with eight LED that provide real-time
information about the device's status, operation, and connectivity. Understanding these signals helps
users quickly diagnose normal operation, initialization, warnings, and potential errors.

LEDs Left side
L1. Device status
e Green blinking 2s - device ready, OK
. still - just init (about 1s)
¢ Red blinking - overtemperature (> 55°C) warning
¢ Red still - fatal error, power cycle the device. If this LED is still red, contact Advacam technical
support.
L2. Error code LED
e Green blinking according to the error (it does not prevent functionality of the device)
e Inthis case, Technical Support will ask the customer to make 10 s video
L3. Reserved for internal purpose
o Violet still - the device restarted itself (it is not a problem at the device starting, but if this
occurs during measurement, it will probably stop working)
L4. Power supply for the row segment
. still - power on (when pixet is running)
e The LED stays on even when Pixet crashes!
LEDs Right side

R1. FPGA
. still - shutter is open
. changes to Red during init

e ltisused also during IP reset procedure (described below)
R2. Device power
e Blue still - power on
e Blue blinks shortly during init
e Blue still and Green blinking (result is Blue- ) - communication with Pixet during FW
revert procedure (described below)
R3+R4. Eth link (R3 Green, R4 Red)
¢ None - no connection
¢ Only Green blinking - 1 Gbit/s, ok
e Only Red blinking - lower speed
e Both Red and Green blinking - lower speed
e Both Red and Green blinking shortly during init
e Both Red and Green still - connected to switch, but without access to network
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2. Pixet Pro — GUI

Pixet Pro, developed by ADVACAM, is a desktop application for expert users that provides full control
of the Timepix- and Medipix-based detectors. It is used in manufacturing processes such as testing and
calibration, as well as in the development phase. The application is powerful, so inexperienced users
could set the device into a non-functioning state. Recovery is possible by loading the factory settings
shipped with the detector.

This section summarizes basic Pixet Pro settings. For more advanced information, refer to the Pixet
manual under the Help panel in Pixet — Advacam Wiki.

Here you can find summary and basic setting for Pixet, for advance information see Pixet manual under
Help panel in Pixet.

Installation
1. Install the Pixet application from attached USB memory stick or from ADVACAM website:

- Pixet for Windows is distributed as a single executable file for automatic installation. Run
setup.exe and follow the instructions it the setup wizard.

o Pixet for macOS system is distributed as a standard .dmg file. After mounting the pixet.dmg
file a window with disk content will open. To install, move the Pixet file to the Application
folder.

o Pixet for Linux system is distributed as a single .tar file. To install, untar the file at a required
location. The application is launched by executing the pixet.sh script.

2. Run Pixet application. A table with available devices will pop up, see Figure 9. Choose your

device.
% Available Devices - PlXet X
Please select device(s) you want 10 use:
Device IP Address Already Opened
s WidePIX MPX3 POE v2.0 sn: 3153 192.168.1.100 Mo
—
Select All Select None Refresh Cancel OK

Figure 9: Available devices

10
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3. The Pixet program will open. The device ID icon appears in the left panel.
4. Ifitis first time connected to your computer or to new one, error message will appear and

Config. file needs to be loaded.

X Pixet 1.8.4 Build 55cb1927 (250831) - WidePIX A0T-WO0686-10 sn 3153 - PlXet

File View Panels Tools Help
License: Advacam X,

m Il B & C \1 = 0 W
e
¥ Image Properties
Min: 0 Max: 1
. .
) Aute range: Min-Max o
511 m_
Type: Count: Time [s]:

Frames » 100 A~~~ 01

v () Repeat () File output
0 A
® Start
g ¥ Detector Settings
.THLC: LTHL 1: f:
0 X (column number) 1270 Ret THLO R Bie V1
0.0 ~ v 00 5
0 0.25 0.5 0.75 1 Mode: 5V 05uA
SPM 1 CH w [_) 24bit R
Apply Filter
Flat-Field v o e

Messages
Open when new message

FPS:0 | T:0:00:00.0  R:0/0 | A:0/0

Figure 10: Example of new device connected before Config file was loaded. In Detector setting
section THL are without units and values are set to zero. Also, Error message occurred.

5. To Load configuration: File > Load config. > find config file on attached USB driver, it is .xml file
named same as ID of the device (in this show example - AO7-W0686-10.xml)

X Pixet 1.8.4 Build 55cb1927 (250831) - WidePIX AO7-W0686-10 sn 3153 - PIXet - m} X
File View Panels Tools Help
Open Frame... E = 0 A | 52 License: Advacam X
Load Config... Min: 0 Max: 1
Save Config.. [} L]
Load Factory Config Q Auto range: Min-Max ~
Reconnect Ctrl+Shift+R
Save Pixet Config Type: Count: Time [s]:
- Frames v 1000 A~ v 041
m Repeat m File output

Figure 11: Configuration file - loading

11
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6. Configuration file contains default settings of the detector including calibration of energy
thresholds to keV. Settings of thresholds in keV and bias voltage are shown in the Detector
Settings panel when the configuration is properly loaded. The device is now ready for use.
However, it is advisable not to start any measurements until the thermal equilibrium is
established (~ 5 minutes). For CdTe sensors, it is advisable to expose the detector to X-rays for
a few minutes prior to measurement.

7. Last settings are stored locally upon closing Pixet and reloaded the next time the same device
is used. Defaults can be restored any time by loading the default configuration.

X Pixet 1.8.4 Build 55cb1927 (250831) - WidePIX A07-W0686-10 sn 3153 - PiXet = a X

File View Panels Tools Help

m H H o \1 zZ = 0 - L] _'___:_, I License: Advacam X
]
ADT-W0636-10 ¥ Image Properties
Min: 0 Max: 1
. .
|:_| Auto range: Min-Max v
51

Type: Count: Time [s]:

Frames v 100 A~~~ 01

|:| Repeat I:I File output

&) start
: ¥ Detector Settings
0 X (column number) 1279 THL O [keV]: THL 1 [keV]: Bias [V]:
f 4 50 ~ 150
0 0.25 05 075 1] Mode: 147V 327.1 uA
SPM 1CH w () 24 bit 4
|:| Apply Filter
Flat-Field v v 0@

s 4 a Open when new message

(18:18:44.911) No configuration for the device found. Please load the configuration from factory directory or from installation media

Figure 12: Example after loading Config file. In Detector setting section THL shows units and
values from calibration are set. Also, bias voltage is set. (for CdTe, polarity should be set negative

but show positive value under).

12
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Main tool bar

A Pixet 1.8.4 Build 55cb1927 (250831) - WidePIX C06-W0562-5 sn 317 - PlXet = O X
File View Panels Tools Help
Ee BEEHE Q== 0 ~ € B[] License: Advacam X

Figure 13: The icons in the toolbar are described below from the left side to the right side.

Open Frame: Opens and loads measured data from hard disk into
the software. The frames can also be opened by dragging and dropping
frames on to the frame panel.

= Save data: Saves all the measured data (frames) from memory to a hard
drive. Users can choose between several file formats to save the frames.

Show grid: Shows grid over the frame that highlights borders between

= pixels of the frame.
== Show chip ID number
c Rotate clockwise: Rotates the frame clockwise by 0, 90, 180 or 270

degrees.

Color map: In the Color map dropdown box it is possible to select colors
¥ ]
that are used to map values of the frame.

Under warning, Over warning: These two buttons set if the values under
the selected range or over the selected range should be highlighted with
special color. You can set the range using the Min and Max fields in
the Image Properties panel on the right side. For the gray map there are
green color (under values) and red color (over values)

Frame: Shows the frame with selected index. By clicking on arrows
previous or next frame could be shown. Only work with Frame type.

5
&

Auto update: If enabled every new measured frame is automatically
shown in the frame panel. When not enabled, the frames are measured in
the memory but are not shown in the frame panel. To accelerate the
measuring of frames from the device, it is recommended to disable this
option.

Pixel configuration: Shows the pixel configuration toolbar and pixel
configuration frames (Mask bits, Test bits, ...) Measurements: Measurement
utilities.

Python Scripting: Runs the integrated Python console. Program can
control the Pixet program and use graphic features.

13
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Understanding the Medipix3 chip operation - WidePIX CHROMATIC

Comparison of Medipix and Timepix chips

Timepix-based detectors allow both the photon counting and spectroscopic “time-over-threshold”
measurement. Medipix-based detectors operate only in the photon counting mode. However,
the radiation spectra can be measured using a threshold scan.

Timepix-based detectors have single energy threshold. All energies below the set value are cut
off. Devices are set to a minimal threshold above noise by default. This is typically 5 keV.
The threshold can be adjusted by user in the counting mode.

Medipix3 detectors have one or more adjustable energy thresholds. The number of thresholds
varies according to the sensor pixel pitch and the mode of operation. The logic is the same as for
Timepix-based detectors; all available thresholds cut off lower radiation energies. Minimum
threshold is typically higher compared to Timepix-based devices and depends on additional
settings.

Unlike the Timepix-based detectors, the Medipix3 offers several operation modes for the counting
measurement. The list of modes is described in the following section.

Overview of Medipix3 read-out chip operation

Each pixel of the Medipix3 (MPX3) chip has two thresholds and two 12-bit counters, which can be
alternatively merged with one 24-bit counter, providing enhanced dynamic range.

In principle, two main modes of operation are available:

1.

Single Pixel Mode (SPM): every pixel works independently of its neighbors, analogous to Timepix-
based devices.

Charge Summing Mode (CSM): two thresholds are used for energy discrimination. The algorithm
is as follows: the detected quantum of radiation generates an electric charge in the sensor. The
charge is typically collected to two or more pixels and creates an electric signal in each pixel. The
signal is compared to the first threshold in every pixel. Signals below the threshold are cut off
(similar to the SPM). The signal/charge of 4 neighboring pixels is reconstructed (summed) and
assigned to the pixel with the largest charge deposition. The result is then compared to the second
threshold, signals below the threshold are omitted.

The CSM suppresses the effect of charge sharing and the images are sharper in comparison to the SPM.

Both modes can be moreover operated in several ranges which define the minimal and maximal
achievable threshold. Selection of the range affects also further properties, such as the energy resolution
and stability (noise) of the detector. The range setting can be found in literature under the term “gain
mode”.

14
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Mode of operation can be selected via drop-down list in the Detector Settings panel:

SPM 1 CH (Single Pixel Mode - one channel) One counter is in use. One energy threshold (energy
channel) is available. Output: one 12-bit or 24-bit image representing the number of events per pixel.

THL O [keV]: THL 1 [keV]: Bias [V]:

8.0 A v 101 A w2350
Mode: 34TV 264 uA
SPM 1 CH ~ () 24 bit P

SPM 2 CH (Single Pixel Mode - two channels) Two counters are in use. Two energy thresholds (energy
channels) are available. Output: two 12-bit images representing the number of events per pixel.

THL O [keV]: THL 1 [keV]: Bias [V]:
&0 A~ 101 Ao =350

Maode: 347V 252 uA
seM2cH  ~ () A

CSM (Charge Summing Mode) Two energy thresholds are in use. Output: one 12-bit or 24-bit image
representing the number of events per pixel. For more information see tutorial How to use CSM.

THL 0 [keV]: THL 1 [keV]: Bias [V]:
8.0 A~ 100 A~ 2350

Mode: M7V 251 uA
CSM v () 24 bit A

After changing the operation mode, values of the energy thresholds may change according to

the respective energy calibration.

Counter depth is set to 12 bits by default. Check the checkbox in Detector Settings panel for 24-bit

depth.
THL O [keV]: THL 1 [keV]: Bias [V]:
8.0 A~ 10 A~ 2350
Mode: 34TV 16,6 uA
SPM 1 CH ~ (@ 24 bit o

15
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Setting the range - advanced /A

Click on the More Detector Settings button in the Detector Settings panel. New window will appear.
Select the range in the drop-down list within the Settings section of the first Detector tab:

« Broad - the largest threshold range.
« Narrow - better energy resolution at lower energies.

« Super Narrow - very limited threshold range, the best energy resolution at lower energies, better
signal-to-noise ratio, this range does not support CSM operation mode.

Click OK to confirm the changes.

By default, the detector will be calibrated for the Narrow gain mode. Additional gain modes can be
added upon request. Broad range and combination of Super narrow mode with CSM is not available
with silicon detectors.

X More Detector Settings - PIXet X

Detector Chip Layout

~Information

Full Name: WidePIX A07-W0686-10
Device Serial: 3153

Chip Type: Medipix3 RX
Calibration: No

Parallel Readout: No

~Settings

Range (Gain mode):

O Continuous Mode

Narrow (HGM) ~

| Narrow (HGM)
Broad (SLGM)

~Custom Settings

Super Narrow (SHGM)

;

Counter: Counter0  ~ ‘
Counter Depth: 12 bits ~ |
Colum Block: All hd
Row Block: All e |
Disc CSM SPM: Disc 0 ~

Cancel

Figure 14: More detector settings

Note: More Detector Settings section is intended for expert users only. Any modification of Custom
Settings section may lead to unpredictable behavior of the device!

16
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Useful tips and how-tos

Here are several tips for more effective and comfortable use:

« Composition of panels on the right side of the Pixet window can be configured in Panels in menu bar.
« Orientation of the image (rotation, mirroring) can be customized in View drop-down list in menu bar.
« To keep the aspect ratio of the image, click on View > Ensure Aspect Ratio in menu bar.

« Default colormap is gray. Colormap can be selected via drop-down list under the Multicolored icon
located in main toolbar.

- Image Properties panel allows you to adjust brightness and contrast of the displayed images
by setting the range to be displayed. Auto range option provides automatic adjustment.

. Advanced Image Properties panel allows to set gamma correction for better visibility of features
within measured sample.

. Pixet allows opening and showing previously saved images by drag and drop into image area of
the Pixet window. When multiple images are dragged and dropped, one can browse them using blue
arrows in the main toolbar.

« Images can be zoomed by holding the left mouse button in the frame, dragging the mouse to create
a selection rectangle and releasing the mouse button. To restore the original frame size, double click
on the image.

« Application output including error messages are shown in Messages panel.
« In case of hardware disconnection, the device can be reconnected by clicking File > Reconnect
in menu bar without restarting Pixet application.

& Pinet 1.84 Build 551927 (250831) - WidePIX COB-W0562-5 sn 317 - Piket - o x

Figure 15: Message panel with Error messages.

Synchronization

This feature is available for WidePIX CHROMATIC Industry and SenseEdge models upon request.
For detailed information, please contact ADVACAM Support support@advacam.cz.

17
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3. Practical examples of measurements

Measurement in SPM 1 CH - using one threshold

Set the device to SPM 1 CH operation.
Switch on / off the 24-bit counter depth (optional).

Set first threshold (if needed) THL 0 [keV] to desired value (It is not recommended to use lower value
than shown after Loading Config file). Second threshold THL 1 [keV] is not in use for this operation
mode.

Note: If [keV] is not shown, Config. file was not loaded.

THL O [keV]: THL 1 [keV]: Bias [V]:
8.0 ~ 0 v 2350

Mode: 34TV 264 ul
SPM 1 CH [ 24 it A

Figure 16: Detector setting for SPM1

Controlling the measurement parameters via Measurement panel
Select type of measurement in Type drop-down list. There are two options:
For single acquisition select Frames and set parameter Count to 1.

Integral — several acquisitions are added to one frame. Number of acquisitions to be added is defined
by parameter Count.

Set the exposure time of individual frame acquisitions in seconds using Time [s].

Checking the Repeat checkbox and setting the number of repetitions using the text box underneath will
cause repeating the defined measurement several times. Setting the number of repetitions to zero value
means “repeat forever”. If the Repeat checkbox is unchecked, the number of repetitions is not in use.

¥* Measurement

Type:

Frames

Count: Time [s]:

0.1

o 1 A T

() Repeat (") File output §o

R

0 A

@ Start

Figure 17: Measurement panel

Note: In case of combining Repeat and Frames, it is advisable to set the Count parameter to value
greater than 1, especially for acquisition times shorter than 1 s. This prevents unwanted increase in dead
time measurement.

18
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Starting the measurement

Start / stop the measurement using Start / Stop button on the Measurement panel. Progress of
the measurement is shown in the status bar at the bottom of the window.

Once the measurement is finished, the measured frame is shown in the image preview area of the Pixet
window.

Automatic saving of measured data

Check File output in Measurement panel for automatic saving. Then click on the button with three dots.
A system dialog window will appear to Select the target destination and filename. Confirm by clicking
the Save button. Measured data are saved automatically during the measurement. A warning dialog
will appear if the file name and destination is used for another measurement.

* Measurement

Type: Count: Time [s]:

Frames w1 A~ 01

|:| Repeat File cutput §op
0 Ao AWidePix_CH_10_sritest. bt

@ Start

Figure 18: Automatic saving example.
Two files are saved by default to each frame:
. data file (.txt)

« Description file (.dsc) which contains information about the device, used configuration,
measurement settings, etc.

For detailed Saving option, see YouTube tutorial Data saving and Data format

Manual saving of measured data

Click on File > Save Data option in menu bar or Saving icon or Ctrl + S. A system dialog window will
appear. Select what you want to save, see Figure 19.

Save raw data option will save last set of measurements. Save Current Frame option will save current
frame from screen with applied filters. Option Save All Frames is similar to the Save raw Data in this
case.

Select the target destination and filename and confirm by clicking the Save button.
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X Save Data - PlXet X

-Save Data

O Save raw data to frames or other format

O Save the currently visible frame as shown on screen with
selected image range, applied calibraticn or filters te file (frame, image, ..)

O Save all measured frames frem memery to frame or image files with
selected image range, applied calibration or filters.

| QK Cancel

Figure 19: Saving options

Measurement in SPM 2 CH - using two thresholds
« Set the device to SPM 2 CH operation mode as described above.

o 24-Dbit counter depth is not available.

e Set both thresholds THL O [keV], THL 1 [keV] to desired values. Second threshold should be
higher than the first threshold. It is not recommended to use lower value than shown after Loading

Config file.
THL O [keV]: THL 1 [keV]: Bias [V]:
8.0 AW T02 A w350
Mode:
SPM 2 CH v ) b

Figure 20: Detector setting for SPM 2. THL 1 should be higher than THL 0O

Controlling and starting the measurement is same as in example for SPM 1.

Once the measurement is finished, the measured frames are shown in the image preview area of
the Pixet window. Use buttons below the image to switch between the energy channels.

Saving measurement is similar as in example for SPM 1 CH. Four files are saved by default:
« data file (.txt) for first channel with ending “_THLO"

« description file (.dsc) for first channel with ending “_THLO”

« data file (.txt) for second channel with ending “_THL1"

« description file (.dsc) for second channel with ending “_THL1"
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« Set the device to CSM operation mode as described above.

«  Switch on/ off the 24-bit counter depth as described above (optional).
« Set both thresholds THL 0 [keV], THL 1 [keV] to desired values. Second threshold must be higher

than first threshold.

THL 0 [keV]: THL 1 [keV]: Bias [V]:
2.0 A~ 100 A 2350

Mode: 347V 251 uA
CSM v () 24 bit A

Figure 21: Detector setting for CSM

Controlling and starting the measurement is same as in example for SPM 1.

Measurement in Time Delayed Integration regime

Time Delayed Integration (TDI) is implemented for WidePIX CHROMATIC Single Row devices only
and is available upon request. TDI can be used for continuous scanning where, for example, samples
move on a conveyor belt along the detector.

To switch on / off this functionality click on More Measurement Settings button in the Measurement
panel. New window will appear. Then check / uncheck Time Delayed Integration (TDI) checkbox
in the Advanced Measurement Settings section on the first tab General. Confirm the change by
clicking OK.

All operation modes, bit depths and ranges of static measurement (as described in previous section) are
implemented also in TDI.

Alignment of the experiment

Sample measurement has to move along with the detector. Movement of the sample with respect to
the WidePIX device must be in the sense from the top to the image bottom (i.e. towards the device
readout peripheries; by default, the image in Pixet is oriented with peripheries at the bottom).

Set the operation mode, counter depth and energy threshold(s) as desired. Switch on the TDI regime
as described above.

Measurement panel

« Set the Type of measurement to Frames.

« Set number of frames into Count.

. Enable repeating and set number of Repeats.

« Set acquisition Time [s] corresponding to the movement of the sample by chip size (dead time for
the chip read-out should be included). The chip size is 256 x 0,055 = 14,08 mm. Hence,
the exposure time corresponds to the speed the sample moves along this distance. To achieve
perfect synchronization time can be optimized by evaluation of object sharpness.
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4. Advanced control using Python Scripting

The Pixet GUI has Python Scripting. This plugin allows the user to perform complex measurements
controlling the detectors automatically via Python commands and scripts. Click on the Python Scripting
icon on the right edge of the main toolbar to start the Python Scripting plugin. A new window with
simple editor will open. The window contains a python console, where python commands can be run
one by one with immediate output. The console also contains the output of executed python script.

The Python Scripting embeds a full python 3.12 (for Pixet Pro 1.8.4 and older, python 3.7.x was used)
interpreter including the standard python libraries. All standard functionality of python is therefore

accessible. Please refer to www.python.org or www.learnpython.org for more information about Python

programming language. List of functions can be found also in the main panel of the Python Scripting
window Help > Function List...

A Python Scripting - Pl¥et — a * ]
File Edit Script Help
OEH P L]
Untitled.py B
1
Welcome
o

Interpreter is started.

Figure 22: Python Scripting window.

The Pixet API (Application Programming Interface) is accessible in the scripts via a pixet variable. This
variable represents the IPixet object that provides all the necessary methods to get information about
all connected devices, log messages to log file, access the Pixet menu, etc. A list of all available objects,
methods and constants of the Pixet API can be found on Python API.
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Sample script #1

Detector settings (operation mode, counter depth, range, threshold), simple acquisition

# get list of all connected Medipix3 devices
devices = pixet.devicesByType(pixet.PX_DEVTYPE_MPX3)

# get first device from Llist
dev = devices[0] # returns IDevMpx3 object

# set operation mode
dev.setOperationMode (pixet. PX_MPX3_OPM_SPM_1CH)
# SPM 1 CH: pixet. PX_MPX3_OPM_SPM_1CH (0)

# SPM 2 CH: pixet. PX_MPX3_OPM_SPM_2CH (1)

# CSM: pixet.PX_MPX3_OPM_CSM (2)

# get operation mode

print('Operation mode: ' + str(dev.operationMode()))

# set counter depth
dev.setCounterDepth(pixet.PX_MPX3_CNTD_24B)
# 12 bits: pixet. PX_MPX3_CNTD_12B (2)

# 24 bits: pixet. PX_LMPX3_CNTD_24B (3)

# get counter depth
print('Counter depth: ' + str(dev.counterDepth()))

# set range

dev.setGain(pixet. PX_MPX3_GAIN_SUPERHIGH)

#  Super Narrow: pixet.PX_MPX3_GAIN_SUPERHIGH (0)
#  Narrow: pixet. PX_MPX3_GAIN_HIGH (1)

# Broad: pixet. PX_MPX3_GAIN_SUPERLOW (3)

# set threshold

th_index = pixet.PX_MPX3_THO # index of threshold to be changed

# THL O: pixet.PX_MPX3_THO (0)

# THL 1: pixet.PX_MPX3_TH1 (1)

chip=4 # chip index (chips are counted from 0!, choose Chip number - 1)
# chip #1: O

# chip #5: 4

# all chips: pixet. PX_CHIP_ALL (-1)
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th_energy = 30 # new value of threshold in keV
dev.setThreshold(chip, th_index, th_energy, pixet. PX_THLFLG_ENERGY)

# acquisition

acqCount =1 # number of acquisitions

acqTime = 10 # time of acquisition in seconds
dev.doSimpleAcquisition(acqgCount, acqTime, pixet. PX_FTYPE_NONE, ")

# get last acquired image
frame = dev.lastAcqFrameRefInc()
data = frame.data()

Sample script #2

Integral acquisition, saving the data

# get first device from list of all connected Medipix3 devices
dev = pixet.devicesByType(pixet. PX_DEVTYPE_MPX3)[0]

# set operation mode
dev.setOperationMode (pixet.PX_MPX3_OPM_SPM_2CH)

# set acquisition parameters

acqCount = 10 # number of acquisitions for integral measurement
acqTime =0.1 # time of one acquisition

fileName = "./test/image.txt'

# integral acquisition, saving
dev.doSimplelntegralAcquisition(acgCount, acqTime, pixet.PX_FTYPE_AUTODETECT, fileName) # data are
automatically saved
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Sample script #3

Threshold scan

# get first device from list of all connected Medipix3 devices
dev = pixet.devicesByType(pixet.PX_DEVTYPE_MPX3)[0]

# set operation mode
dev.setOperationMode (pixet.PX_MPX3_OPM_CSM)

# set acquisition parameters

th = pixet.PX_MPX3_TH1 # index of threshold to be changed
ths = range(10,45,5) # thresholds in keV

acgCounts = [1 for number in ths]

acqTimes = [0.1 for number in ths]

output ="./test_' # destination path

# threshold scan
for i in range(len(ths)):
print('TH: {}' format(thsli]))

dev.setThreshold(pixet.PX_CHIP_ALL, th, ths[i], pixet. PX_THLFLG_ENERGY)

fileName = output + str(ths[i]).zfill(3) + 'keV.txt'

dev.doSimplelntegralAcquisition(acqgCountsJi], acqTimesli], pixet. PX_FTYPE_AUTODETECT, fileName)
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5. Power Supply Wiring (Alternative to PoE)

When using the optional M12 connector for external power (48V DC, min 50 W), the wiring must be

e

done. Connect as follows:

e Pin1l:+48VDC

e Pin3:GND

e Pin 2 and Pin 4: Do not connect (Auxiliary pins are not used in this configuration)
¢ FE (Functional Earth): Connect to chassis ground for shielding.

Ensure the Ethernet cable is used only for data transfer in this configuration.

Warning: Do not connect PoE and the external power adapter simultaneously!
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